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Introduction

Bluetooth is an open specification for a cutting-edge technology that enables short-range
wireless connections between desktop and laptop computers, personal digital assistants,
cellular phones, printers, scanners, digital cameras and even home appliances — on a
globally available band (2.4GHz) for worldwide compatibility. In a nutshell, Bluetooth
unplugs your digital peripherals and makes cable clutter a thing of the past. Now you can
connect your PDA or PC to Bluetooth™ enabled mobile phone with this Bluetooth™
adapter.

You can access e-mail & Internet no matter where you are with just a little help from your

Bluetooth™ mobile phone.
Plus, when you are back in the office, you can hook yourself up to your office network as
well as communicate with other Bluetooth™-enabled devices.




Chapter1

Supported profiles
Windows 98SE/ME

This Bluetooth Stack for Windows supports the following profiles. Please note that
profiles HSP, PAN, BIP, A2DP, AVRCP and GAVDP are supported by Windows XP and
Windows 2000 only.

(a) Dial-Up Network (DUN)

(b) Fax profile (FAX)

(c) Local Access Profile (LAP)

(d) Serial Port Profile (SPP)

(e) Human Interface Devices (HID)

(f) Hard Copy Replacement Profile (HCRP)

(g) File Transfer Profile (FTP)

(h) Object Push Profile (OPP)

Windows 2000/XP

(a) Dial-Up Network (DUN)

(b) Fax profile (FAX)

(c) Local Access Profile (LAP)

(d) Serial Port Profile (SPP)

(e) Human Interface Devices (HID)

(f) Hard Copy Replacement Profile (HCRP)




(g) File Transfer Profile (FTP)

(h) Object Push Profile (OPP)

(i) Headset Profile (HSP)

(j) Personal Area Network (PAN)

(k) Basic Imaging Profile (BIP)

(I) Advanced Audio Distribution Profile (A2DP)
(m) A/V Remote Control Profile (AVRCP)

(n) Generic Audio Video Distribution Profile (GAVDP)

Supported languages

The Bluetooth Stack for Windows supports the following languages.

English
Danish
French
German
Italian
Japanese
Norwegian
Spanish
Swedish

The following languages are supported by Windows XP and Windows 2000 only.

Dutch

Korean

Simplified Chinese
Traditional Chinese
Russian

Finnish

Portuguese (Brazil)

Supported operating systems
The Bluetooth Stack for Windows supports the following operating systems.
Windows 98 Second Edition

Windows ME
Windows 2000 Professional (Service Pack 3 or above)




Windows XP Professional (Service Pack 1 or above)
Windows XP Home (Service Pack 1 or above)
Windows XP Tablet PC Edition

Windows XP Media Center Edition

Limitations

(a) External Bluetooth drivers cannot be "signed drivers" to receive Microsoft WHQL logo.
Therefore, Microsoft's "Unsigned driver" warning messages may pop up during the
software installation, Bluetooth headset, mouse or keyboard setup. Please install the
drivers and then follow the on-screen instructions.

(b) On Swedish Windows XP, an error message (error code = 633) may be seen during
dial-up. Please update the operating system to Windows XP Service Pack 2 or refer to
Microsoft knowledge base #831717.

(c) Windows XP fast user switch is not supported. When switching to another user, the
Bluetooth Manager is not launched. Please log off before switching to another user.

(d) If "automatic FAX receiving" is enabled on Microsoft FAX manager, and if DUN, FAX,
or LAP profile icon is registered on Bluetooth Settings, and then Bluetooth's "resume from
standby" may take a couple of minutes to turn on.

(e) Windows 98 Second Edition: If the "Install New Modem" dialog pops up when setting
up a Bluetooth modem, mobile phone, or access point, please choose "Don't detect my
modem; | will select from a list". Otherwise, the system may freeze during the modem
detection. If the manual for your Bluetooth device does not specify a modem driver, then
please select "Standard 33600bps modem".

(f) Before connecting or disconnecting a Bluetooth headset, please exit any voice or
sound-related applications (e.g. Windows Messenger, Windows Media Player). The
audio input and output may not be switched properly if those applications are running.
This same precaution is important prior to system standby, hibernate or shutdown, and
prior to turning off or unpluging the primary Bluetooth device.




Chapter2
Setup for Windows 98SE/ME/2000/XP

Installing Bluetooth software for Windows

1. Please insert the accompanying CD and the setup menu should launch
automatically. If the setup menu does not launch automatically, use Windows
Explorer to navigate to the appropriate CD-ROM drive and run "setup”.

Setup Program

(

2.  When the License Agreement screen is displayed, read the License Agreement, then
click the radio button to the left of "l accept" and then click the “Next” button.




Bluetooth Stack for Windows by Toshiba Setup

TOSHIBA CORPORATION iad
End User License Agreement

This End User License Agreement (EULA] is a legal agreement between you and
TOSHIBA CORFORATION ([TOSHIBA) with regard to the copyrighted Software provided
with this EULA,

Use of any software and related documentation (Software) made available by

downloading or otherwise to you by TOSHIBA in whatesver form or media, will constitute

wour acceptance of these terms, unless separate terms are provided by the software |
supplier, in which case certain additional or different terms may apply. If you do not agree  |v|

(* | accept

" | don't accept

Ok Cancel

3. During the installation, the system will try to detect your Bluetooth device, please plug
in your Bluetooth device and then click on the “OK” button.

Bluetooth Stack for Windows by Toshiba Setup

L3
\'_!:) Flease plug in the Blustaoth device and click O butkan.

Cancel

4. When the installation is completed, please click on the "Yes" button to restart your
system.

Bluetooth Stack for Windows by Toshiba Setup

i You must restart wour sysem For the configuration changes made ko Bluetooth Stack For Windows by Toshiba ko take
effect, Click ¥es to restart now ot Mo if wou plan to restart later,




Chapter 3

Basic setting

Methods for registering new devices using the Bluetooth Utility shall now be described.
A Bluetooth mouse shall be connected and set up using [Bluetooth Settings] as an
example.

[Bluetooth Settings] provides two set-up methods: "Express Mode" and "Custom Mode."

o Express Mode
[Bluetooth Settings] will automatically detect and register services. If several
services (profiles) are supported by the device the service that has been set to the
highest priority shall be selected and registered.
Express Mode is normally recommended for device set-up.

e Custom Mode
After having been detected, the services supported by the device are displayed as
a list, from which you can select the desired function(s).
Custom Mode must be used to set up a device if, for example, you wish to use a
modem station to send a fax (because in Express Mode, the DUN profile will be
automatically selected since it has a higher priority than the FAX profile).

The differences between setting up the same device (a Bluetooth mouse) using Express
Mode and Custom Mode are described on the following pages.

3.1 Express Mode Set-up

3.1.1 Starting Bluetooth Settings

. . Registerin,
Starting Bluetooth Detecting . . BIS _g
X > . # Detecting services | settings
Settings Bluetooth devices . e
information

1. Click [Start]>[All Programs]>[Bluetooth]>[Bluetooth Settings].
(Under Windows 2000, click [Start}]—[Programs]—[Bluetooth]—[Bluetooth
Settings].)




Note
- The same result can be achieved by right-clicking on the Bluetooth icon in the
task tray and selecting [Bluetooth Settings] from the menu that appears.

Bluetooth Settings

Add Mew Connection

Options

Help
Exit

| i 10:29 PM

The [Bluetooth Settings] window below will appear when other devices have
already been registered.

L Bluetooth Settings =X
Bluetooth Miew Help
;- E ﬁ Bluetoath

D oetai .| | 2 elete

Please click the [New Connection] button to open the [Add New Connection Wizard]
window. If no devices have been registered yet, please proceed directly to
"Detecting Bluetooth Devices."

3.1.2 Detecting Bluetooth devices

i i Registering
Starting Bluetooth Detecting . . :
i ] . # Detect 5 5 sett
Settings Bluetooth devices clecting services _ settings
information

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] window
will appear.




1. Switch the device power ON to make it connectable via Bluetooth.

2. Confirm that [Express Mode] has been selected in the [Add New Connection
Wizard (Welcome to the Add New Connection Wizard)] window, and click on
the [Next] button.

‘Add New Connection Wizard

Welcome to the Add Mew Connection Wizard

Thiz vazard registers Hee connechion information of a remote
dawice,
Select the wizard mode.

(#) Exprass Mode [Fecommended)
The mioet uzeful sarvice on a remobe device iz set up.

() Custom Mode

An avalable serace on a remole device iz selected and et
up.

[ New> | [ Cancel |
Searching for Bluetooth devices will start.
fdd MHew Connection Wizard
Searching for Bluetooth devices.
Searching for Blustooth devices.

When the device has been detected, the name and address of the device will
appear in the [Add New Connection Wizard (Select Device)] window.




Select a device

Please choose the Bluetooth device you wizh bo use.

Bluetocth dewvice addiess

Dievice fizk
| Deviea Hame Dewice Addiess |
| BT MHouse- [ |

|

[ <Back || New> || Cancal ]

Note
- If no device is found, please confirm that the device has been made

connectable via Bluetooth, and click on the [Update] button.
- A further device search will be performed.

3.1.3 Detecting services

. . Registering
Starting Bluetooth Detectin . . .
E" r B r| Detecting services settings
Settings Bluetooth devices . .
information

1. Select the device name from [Device List] and click on the [Next] button.

10



Please choose the Bluetooth device you wizh bo use.

Bluetocth dewvice addiess

Device list
: Diawice Mame Dewice Addiess | .
| BT Mouze1 0003 FAc 08 Ta BY ]

|

[ <Back || New> || Cancal ]

Bluetooth device detection will commence.

Note

- If several services (profiles) are supported by the device, the service that has
been set to the highest priority shall be automatically selected and set up in
Express Mode. Please use Custom Mode if you wish to select desired services

Pleaze wait while wizard searchesz for remote device services.

The local device iz searching for remote: device senices.

manually.

- When a service has been detected, a window prompting you to enter the
Bluetooth passkey (PIN code) may appear. Please enter the passkey and click

on the [OK] button.

1




Bluetooth Manager - Bluetooth Security

Elustooth Fasskey [FIN}

Fl

Request Device
Blustooth Device Addiass:
Eluetooth Device Mame:

(IF ledt blanik, the defeult FIN wil be used )

00:07:61:01:81:DE
BT-houze-1
[ ok ][ cCancel

- If you have not entered your Bluetooth passkey after a certain amount of time

has passed, the connection process will be cancelled for security reasons.
Please perform the passkey entry process again.

A message will appear prompting you to prepare the device for connection.

2. Click on the [OK] button.

Bluetooth Settings
-
J() Prepare to connedt bo the remate HID desvice, then dick C8.

Note

- When the settings information has been registered, a window prompting you to
enter your Bluetooth passkey (PIN code) may appear. Please enter your passkey

and click on the [OK] button.

Bluetooth Manager - Bluetooth Security

Blustooth Passkey [FIN}

F

Request Device
Elustooth Device Addiess:
Bluetooth Device Mams:

{IF ledt Blark, the: default FIN wil be used

00:07;61:01:81:DE
BT-Mousze-1
[ ok ][ cancel

- If you have not entered your Bluetooth passkey after a certain amount of time

has passed, the connection process will be cancelled for security reasons.
Please perform the passkey entry process again.

12



The [Add New Connection Wizard (Connection Name Setup)] window will appear if
a service has been properly detected.

3. Select the type and name of the icon to be displayed once the device has
been registered, and click on the [Next] button.

‘Add New Connection Wizard

Enter a name and select an icon.

Setup the conmechion name and icon.

Settng infomation

' Connection Name:

BT-Mouze-1

lcon

6

' [] Creste & shadeat on the deskbop

i [cBack. [ New> ] [.Cancal ]

Note
- If you wish to change the icon, please click on the [Change Icon] button and
select your preferred icon from the list that appears.

l:Chunga lcons . a

HElmOMS
mE E O=E
srzsd @ DU
aang B[ W9
EMEH T

13



3.1.4 Registering settings information

Starting Bluetooth Detecting L gistering
Settings "| Bluetooth devices g "E S AR sefting
information

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] window
will appear.

1. Click on the [Finish] button

Add Mew Connection Wizard

Completing the Add New Connection Wizard

Regehation of connechon infomation complete.

| <Back || Fish | | Cancal ]

The [Bluetooth Settings] window will appear.
The icons of the registered devices will appear, and the devices will be ready to
use.

= Bluetooth Settings (=] =
Blestaoth  View Help

- € Bluetooth
o
o [ @ etei...| | 76 Detete |
Connection

14



3.2 Custom Mode Set-up

3.21

1.

Starting Bluetooth Settings

. . Registering
S - ].31 i » Detectmg_ »| Detecting services settings
Settings Bluetooth devices . .
information

Click [Start]=>[All Programs]->[Bluetooth]->[Bluetooth Settings].
(Under Windows 2000, click [Start]—[Programs]—[Bluetooth]—[Bluetooth
Settings].)

Note
- The same result can be achieved by right-clicking on the Bluetooth icon in the
task tray and selecting [Bluetooth Settings] from the menu that appears.

Bluetooth Settings

Add Mew Connection

Options

Help
E:xit

| % 10:29 PM

The [Bluetooth Settings] window below will appear when other devices have
already been registered.

L Bluetooth Settings == %)
Bletooth View  Help
.; ~ €3 Blugtooth

D Detai | | 7€ Delete

15



Please click the [New Connection] button to open the [Add New Connection Wizard]
window. If no devices have been registered yet, please proceed directly to
"Detecting Bluetooth Devices."

3.2.2 Detecting Bluetooth devices

. . Registeri
Starting Bluetooth b3 & Detecting services iﬂ:l:r sn :

Settings "| Bluetooth devices a g o e
information

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] window
will appear.

1. Switch the device power ON to make it connectable via Bluetooth.

2. Confirm that [Custom Mode] has been selected in the [Add New Connection
Wizard (Welcome to the Add New Connection Wizard)] window, and click on

the [Next] button.

Add Hew Connection Wizard

Welcome to the Add Mew Connection Wizard

Thiz vazard regsters e connechion information of a remole
davica.
Select the wzard mode.

() Exprezs Moda [Recommended)
Thi most usedul service on a remobe device iz set up,

(=) Cugtom Mode
An avalable senace on a remole device iz selected and set
up,
[ Heut > ] [ Cancal ]

Searching for Bluetooth devices will start.

16



Add New Connection Wizard

Searching for Bluetooth devices.

Searching for Blustooth devices.

When the device has been detected, the name and address of the device will
appear in the [Add New Connection Wizard (Select Device)] window.

Please chooze the Blustooth device you wizh bo use.

Bluetocth dewvice addiess

Device list
: Diawice Mame Dewice Addies: |
| BT MHouse- MOOE7AETSET

|

[ <Back | Mew> | [ Cancal ]

Note
- If no device is found, please confirm that the device has been made
connectable via Bluetooth, and click on the [Update] button.
- A further device search will be performed.

17



3.2.3 Detecting services

. . Registerin
Starting Bluetooth Detecting pIsieriig
- > q settings
Settings Bluetooth devices . .
information

1. Select the device name from [Device List] and click on the [Next] button.

=

‘Add Mew Connection Wizard 4_'|

Select a device

Pleass choose the Blustooth device you wizh bo uss.
Blugtooth device addiess
Device list

. Device Manmes Device Addiess

| [BT-Mouzed

| ET-Madem O0:03: 74094846

[ <Back | Mew> | [ Cancal ]

Bluetooth device detection will commence.

‘&dd New Connection Wizard i

Pleaze wait while wizard searches for remote device services.

The local device iz searching for remobe davice services.

18



Note

- When a service has been detected, a window prompting you to enter the
Bluetooth passkey (PIN code) may appear. Please enter the passkey and click

on the [OK] button.

Bluetooth Manager - Bluetooth Security

Eluetooth Passkey (PIN}
Request Device
Elustooth Devica Addiezs,
Eluetooth Device Mame:

{IF lesdt bharik, the: default FIN wil be used )

00:07:61:01:81:0E
BT-Mousze-1
[ ok ][ cancel

- If you have not entered your Bluetooth passkey after a certain amount of time
has passed, the connection process will be cancelled for security reasons.
Please perform the passkey entry process again.

- If you try to register a device that has already been registered, the following

message will appear, and you will not be able to proceed with further operation.
Please click on the [OK] button to close the message.

Bluetooth Settings

X |

! E This HID device ks already registared.

The services supported by the device will be displayed.

2. Select the desired service and click on the [Next] button.

19



Select a seivice.

Pleaze chooze the service touse.

Service welaction

Sesvice Class Sesvice Mame
=/ Husman Inberface Device Cordless Pieserter

< | |l

[ <Back || Nest> | | Cancal

Note
- When a device supports several services
If the device supports several services, you can use Custom Mode to manually
select the services (profiles) you wish to use from the list that appears under
[Select Services].

Example: List of wireless modem station services

Service sefachon

Service Clags Service Mame

[} Didtup Metwo... Dislup networking
CiFa Faw
& Seiial Fon Serial Post

If Express Mode is used to perform the set-up, the highest-priority service in the
device will be automatically selected and configured.

3. Click on the [OK] button.

‘Bluetooth Settings %]

L3
\'!l) Prepare to connedt bo the remobe HID denice, them dick O,




Note
- When the settings information has been registered, a window prompting you to

enter your Bluetooth passkey (PIN code) may appear. Please enter your passkey
and click on the [OK] button.

Bluetooth Manager - Bluetooth Security

Blustooth Passkey [FIN}
ﬁ {f left tharik, the detault PIN wil be used )
Request Device
Elustooth Device Addiess:  00:07:61:01:81:0E
Eluetooth Device Mama: BT-Mousze-1

[Lok ][ cowa ]

- If you have not entered your Bluetooth passkey after a certain amount of time

has passed, the connection process will be cancelled for security reasons.
Please perform the passkey entry process again.

The [Add New Connection Wizard (Connection Name Setup)] window will appear if a
service has been properly detected.

4. Select the type and name of the icon to be displayed once the device has
been registered, and click on the [Next] button.

Add New Connection Wizard

Enter a name and select an icon.

Setup the conmechon name and icon.

Settng infomation
Connection Name:

BT-Mousze-1

5

[] Creste a shoteuwt on the deskiop

[ <Back ]| Ned> | | Cancal |

21



Note
- If you wish to change the icon, please click on the [Change Icon] button and
select your preferred icon from the list that appears.

’-Chunga lcons ﬁj

FSEmOMS
my l OQE
=aas g ®ID(HUY
s @[ 9
EM=H Y

[ ok ][ Ccancal




3.2.4 Registering settings information

. . Registerin
Starting Bluetooth Detecting L cgistering
Settings "| Bluetooth devices g "E S AR ! setting
information

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] window
will appear.

1. Click on the [Finish] button

Add Mew Connection Wizard

Completing the Add New Connection Wizard

Regehation of connechon infomation complete.

| <Back || Fish | | Cancal ]

The [Bluetooth Settings] window will appear.
The icons of the registered devices will appear, and the devices will be ready to
use.

23



Bletooth Miew Help

€3 Bluetooth
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Chapter 4

Making the most of your Bluetooth device

4.1 Connecting to the internet
411 Connecting to the internet using a modem station
Setting up the modem station
1. Turn on the wireless modem station.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add Mew Connaction
Denic Properties

Pawer OFF

Ciplians k

Help
Exikt

- 15 Qs «

Note
- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings],

and then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.




"fldd Haw Connection Wizard

Thit wizard will create the setling: for Blustooth device connection.

Please ensure pour Bluetooth devices are on and sef to
dizcoverable.

() Cugtom Mode
Thiz alloves pou to set the detas for the connechion.

e | | m—— ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

"ldd Hew Connection Wizard

Searching for Bluetooth devices.

Seaching for Blustooth devices.

4. Select the device name of the wireless modem station from [Device List], and
then click on the [Next] button.




(R ddTiew Connection Wizard

Select a device

Please choose the Blustooth device you wizh bo use.

Bluetocth device

Devvice Mame

PocketPC:
£33 Blstooth Privter

l < Back ][_ﬂaan ][ Cancal ]

The [Add New Connection Wizard (Searching for Services)] window will appear.

tﬁdd Hew Connection Wizard

Pleaze wait while the wizard connects bo a remote device.

The kocal device it connecting 1o the iemabe device
FAVICE.

Please wait

Once a service has been detected successfully, connection to the device and COM
port creation will be performed automatically, after which the [Add New Connection
Wizard (Modem Settings)] window will appear.

. If you are connecting to a wireless modem station for the first time, enter the
passkey for the modem station under [Bluetooth Passkey (PIN code)], and
then click on the [OK] button.

27



(EieeTooTh Wanagar T HlaeTooth SecOriy

Blustooth Passkey [PIN} SEEBERES
‘%% {1 edt blank, the defoult PIN will be used )
Request Device

EBluetooth Device Addiess:  00:00:00:00:00:00
Eluetooth Device Mame: TOSHIBA BT Modem

Lok ][ conce ]

Once the program has finished searching for the devices, the [Add New
Connection Wizard (Device Selection)] window will appear.

6. Click on the [Next] button.

"Add Hew Connection Wizard

Advanced Modem Setlings

Fleaze chek the "dvanced Modam Setiings' button
fios furtheer conhguation options [e.0. for HSCSD o
GPRS) or click "Mext”" lo contines.

| Adheanced Modem Setlings... |

[ <Back || New> || Cancal |

Certain modems require you to configure initialization commands separately.
Please click on the [Additional initialization Command Settings] button, enter the
initialization commands in the following window, and then click on the [OK] button.

Note
- Please refer to the modem or mobile phone instruction manual for further detail
or mobile phone instruction manual for further details on initialization commands.




thd\ramed Modem Settings E

*fou can enter special AT-Commands fos the netalled modem. This
may be necessary for some conneclions, 8.9 GPRS and HSCSD

Flease check the homepage of your providar and your mobile phane

vendor o gel the cotrect seltings. These selings will vary betwesn
dfferant mobde phoms vendors and prowidars.

Examples:
GPRS: +CGEOCOMT=1."IP","apn. provider. de”
HSCS0: +CRST=81,0,1+CHSN-4.0,0,0

Extra inkizlizabon commands:

[ox | [ cence |

7. Enter the connection name (optional), telephone number (of your provider's
access point), user name and password (as issued by your provider), and
then click on the [Finish] button.

“Add Hew Connection Wizard

Create dial-up connection

Pleaze gree the dishup connechon a name, belephone
numnber, and § requied, & user nama and passwond

Dial-up connechion name: | | apdan A

Telspihions number 0207 987 6543
User name: rgoodyS3
Pasawaid: ssssssnass
Confiom passwond: T
[¥] Set a5 Defaut Diakup
[ <Back || Fiish || Cancal |

Important
- The sample entries shown in the window are provided solely for purpose of

explanation. Please use your own telephone number, ID and password
according to the arrangement with your provider.

The settings will be registered, and an icon will appear in the [Bluetooth Settings]
window.




London &

Connecting to the Internet
1. Start your browser, e-mail application or other application

Important
- Please enter the e-mail settings separately if you are going to use e-mail (the

set-up method will vary with the application).

2. Enter the URL of the Web page you wish to display and then press the [Enter]
key, or use the e-mail tool to send/receive items or perform other activities.

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

Dial-up Connection ﬁ

L /] Select the service pou wank bo connect
B o, and then enen pour uzes nams and
pazswand,

Copnecttcc | London A ™

Llser name: rgoodyd9
Passweed SESESEERRANNENEN

[#] Save pazsword
[ Connect automaticaly

| Connect | | Settings.. | | Wk Difiine |

Important
- A connection will be automatically established with the modem station if COM

Auto Connect is available. If COM Auto Connect is not available, please
manually connect to the modem station.

The following message will appear once you have connected to the Internet.

I,, London A is now connected |-

Spead: 115.2 Kbps

30



4. End the connection

The window below will appear if you double-click on the:y icon in the task bar.

i London A Status
Genaral | Dietais
Conmeclion
Shatuz: Caonreched
Diurakion: 000106
Speed 115.2 Kbps
Acinaly
Sent — "ﬁj —  Recsived
Bylas: FAFrE 5382
Compeasgion: 0% ox
Etrars 0 0
| Pmpall'resJ l Digconnect ]
Clase

Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on thegicon, and then click on [Disconnect].

Discannect
Status

Open Network Connections

DS E

Note
- You can start an application to make an automatic connection to the Internet, but

you can also make a manual connection using the connection destination icon.
The procedure is described below.

1. From the [Bluetooth Settings] window, right-click on the connection
destination icon, and then click on [Connect] from the menu that appears.

31



¥ Bluetooth Settings e

Bluetooth  View Help

£ Bluetooth

Delete

Creabe Sharbouk on Desktop
Renams
Change lcong. .. “E ieta

2 B e ———
@m

A window indicating that the connection is being established will appear.

@|:I|:.-r-...tr.'1.-|||.-.--. o (fen’ l.._‘.

Mewe connecing. Please wat .

i

If the connection has been established successfully, the connection icon and task
tray will appear as shown below.

] i/ London A is now connected |
lg Speed: 115.2 Kbps

Londona O ME R WA P WWQO | o2

You will be able to browse Web pages using your browser and send and receive
e-mail.
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Important
- Please enter the e-mail settings separately if you are going to use e-mail (the
set-up method will vary with the application).

2. End the connection
Right-click on the icon, and then click [Disconnect] to end the connection.

& Bluctooth Settings 8=
Bluetaoth  View  Help

£ Bluetooth

Delate:
Detal..,

Create Shorteut on Deskiop
i ————— Rename

Change Toons. ..
wyoeme. | | 3§ Delete

Mz
Connection

The following message will appear. Click on the [Yes] button.

‘Bluetooth Settings

? London & cannot be used if disconnected.
-{r) Are you sure you want ko disconnect?

| ——

When the icon appears as shown below, the connection will have ended.

London A
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4.1.2 Connecting to the internet using a mobile telephone

Important

- In order to connect to the Internet, you must have already signed up with a
provider and obtained a connection ID and password. Please ensure you have
confirmed the ID, password and telephone number of your provider's access
point before you begin the set-up process.

- A Bluetooth passkey (PIN code) is required for you to connect to the mobile
telephone. Please make a note of your Bluetooth passkey before you start the
set-up process.

Configuring a mobile telephone for use a modem
1. Turn on the mobile phone, and set it to be connectable via Bluetooth.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add Mew Conmection
Denic Properties

Power OFF

Ciphions k

Help
Exit

- ¥, Qs «

Note
- Alternatively, click [Start] —[All Programs]—[Bluetooth]—[Bluetooth Settings],
and then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.
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"fldd Haw Connection Wizard

Thit wizard will create the setling: for Blustooth device connection.

Please ensure pour Bluetooth devices are on and sef to
dizcoverable.

() Cugtom Mode
Thiz alloves pou to set the detas for the connechion.

e | | m—— ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

"ldd Hew Connection Wizard

Searching for Bluetooth devices.

Seaching for Blustooth devices.

4. Select the device name of the mobile telephone from [Device List], and then
click on the [Next] button.
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(R ddTiew Connection Wizard

Select a device

Please choose the Blustooth device you wizh bo use.

Bluetocth device

Devvice Mame

PocketPC:
£33 Blstooth Privter

l < Back ][_ﬂaan ][ Cancal ]

The [Add New Connection Wizard (Searching for Services)] window will appear.

tﬁdd Hew Connection Wizard

Pleaze wait while the wizard connects bo a remote device.

The kocal device it connecting 1o the iemabe device
FAVICE.
Please wait

Once a service has been detected successfully, connection to the device and COM
port creation will be performed automatically, after which the [Add New Connection
Wizard (Modem Settings)] window will appear.

. If you are connecting to a mobile telephone for the first time, enter the
passkey for the wireless modem station under [Bluetooth Passkey (PIN
code)], and then click on the [OK] button.
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‘Bluetooth Manager - Bluetooth Security

Blustooth Passkey [PIN} SRR
ﬁ {If ekt blarik, the defoult PIN wil be used )
Request Devics

EBluetooth Device Addiess:  00:00:00:00:00:00
Biluetooth Device Mams; TOSHIEA BT Modem

Lok ][ conce ]

Once the program has finished searching for the devices, the [Add New
Connection Wizard (Device Selection)] window will appear.

6. Click on the [Next] button.

"Add Hew Connection Wizard

Advanced Modem Setlings

Fleaze chek the "dvanced Modam Setiings' button
fios furtheer conhguation options [e.0. for HSCSD o
GPRS) or click "Mext”" lo contines.

| Adheanced Modem Setlings... |

[ <Back || New> || Cancal |

Certain modems require you to configure initialization commands separately.
Please click on the [Additional initialization Command Settings] button, enter the
initialization commands in the following window, and then click on the [OK]
button.
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thd\ramed Modem Settings E

*fou can enter special AT-Commands fos the netalled modem. This
may be necessary for some conneclions, 8.9 GPRS and HSCSD

Flease check the homepage of your providar and your mobile phane

vendor o gel the cotrect seltings. These selings will vary betwesn
dfferant mobde phoms vendors and prowidars.

Examples:
GPRS: +CGEOCOMT=1."IP","apn. provider. de”
HSCS0: +CRST=81,0,1+CHSN-4.0,0,0

Extra inkizlizabon commands:

[ox | [ cence |

7. Enter the connection name (optional), telephone number (of your provider's
access point), user name and password (as issued by your provider), and
then click on the [Finish] button.

“Add Hew Connection Wizard

Create dial-up connection

Pleaze gree the dishup connechon a name, belephone
numnber, and § requied, & user nama and passwond

Dial-up connechion name: | | apdan A

Telspihions number 0207 987 6543
User name: rgoodyS3
Pasawaid: ssssssnass
Confiom passwond: T
[¥] Set a5 Defaut Diakup
[ <Back || Fiish || Cancal |

Important
- The sample entries shown in the window are provided solely for purpose of

explanation. Please use your own telephone number, ID and password
according to the arrangement with your provider.

The settings will be registered, and an icon will appear in the [Bluetooth Settings]
window.
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London &

Connecting to the Internet
1. Start your browser, e-mail application or other application

Important
- Please enter the e-mail settings separately if you are going to use e-mail (the

set-up method will vary with the application).

2. Enter the URL of the Web page you wish to display and then press the [Enter]
key, or use the e-mail tool to send/receive items or perform other activities.

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

Dial-up Connection ﬁ

L /] Select the service pou wank bo connect
B o, and then enen pour uzes nams and
pazswand,

Copnecttcc | London A ™

Llser name: rgoodyd9
Passweed SESESEERRANNENEN

[#] Save pazsword
[ Connect automaticaly

| Connect | | Settings.. | | Wk Difiine |

Important
- A connection will be automatically established with the modem station if COM

Auto Connect is available. If COM Auto Connect is not available, please
manually connect to the mobile telephone .

The following message will appear once you have connected to the Internet.

I,, London A is now connected |-

Spead: 115.2 Kbps
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4. End the connection

The window below will appear if you double-click on the:y icon in the task bar.

i London A Status
Genaral | Dietais
Conmeclion
Shatuz: Caonreched
Diurakion: 000106
Speed 115.2 Kbps
Acinaly
Sent — "ﬁj —  Recsived
Bylas: FAFrE 5382
Compeasgion: 0% ox
Etrars 0 0
| Pmpall'resJ l Digconnect ]
Clase

Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on thegicon, and then click on [Disconnect].

Discannect
Status

Open Network Connections

DS E

Note
- You can start an application to make an automatic connection to the Internet, but

you can also make a manual connection using the connection destination icon.
The procedure is described below.

1. From the [Bluetooth Settings] window, right-click on the connection
destination icon, and then click on [Connect] from the menu that appears.
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¥ Bluetooth Settings e

Bluetooth  View Help

£ Bluetooth

Delete

Creabe Sharbouk on Desktop
Renams
Change lcong. .. “E ieta

2 B e ———
@m

A window indicating that the connection is being established will appear.

@|:I|:.-r-...tr.'1.-|||.-.--. o (fen’ l.._‘.

Mewe connecing. Please wat .

i

If the connection has been established successfully, the connection icon and task
tray will appear as shown below.

] i/ London A is now connected |
lg Speed: 115.2 Kbps

Londona O ME R WA P WWQO | o2

You will be able to browse Web pages using your browser and send and receive
e-mail.
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Important
- Please enter the e-mail settings separately if you are going to use e-mail (the
set-up method will vary with the application).

2. End the connection
Right-click on the icon, and then click [Disconnect] to end the connection.

& Bluctooth Settings 8=
Bluetaoth  View  Help

£ Bluetooth

Delate:
Detal..,

Create Shorteut on Deskiop
i ————— Rename

Change Toons. ..
wyoeme. | | 3§ Delete

Mz
Connection

The following message will appear. Click on the [Yes] button.

‘Bluetooth Settings

? London & cannot be used if disconnected.
-{r) Are you sure you want ko disconnect?

| ——

When the icon appears as shown below, the connection will have ended.

London A
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4.2 Connecting to a network[LAN]
4.21 Connecting to a LAN using an access point[LAP]
Setting up the access point

Important

- The access point must have been started and a normal connection already
established to the network before the access point is set up. Please refer to the
access point instruction manual for information on how to set up the access
point.

- A Bluetooth passkey (PIN code) is required for you to connect to the access
point. Please make a note of your Bluetooth passkey before you start the set-up
process.

1. Turn on the access point, and confirm that a connection has been
established with the network.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add Mew Conmection
Dievice Properties

Pawer OFF

Ciplians k

Help
Exit

= D Qs «

Note
- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings],
and then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.
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"fldd Haw Connection Wizard

Thit wizard will create the setling: for Blustooth device connection.

Please ensure pour Bluetooth devices are on and sef to
dizcoverable.

() Cugtom Mode
Thiz alloves pou to set the detas for the connechion.

e | | m—— ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

"ldd Hew Connection Wizard

Searching for Bluetooth devices.

Seaching for Blustooth devices.

4. Select the device name of the access point from [Device List], and then click
on the [Next] button.
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Add Hew Connection Wizard

Select a device

Please choose the Bluetooth device you wizh bo use.

Bluetocth device addiess

Dievice list

Diewice Mame Dewice Addies: |
[BTART O A CR T |
PCa 0003 74:06:64:83

[v]

[ <Back | Mew> | [ Cancal ]

You will be asked for the Bluetooth passkey in the window that appears.

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on
the [OK] button.

Bluetooth Hanager - Bluetooth Security

Bluetooth Passkey (PIME T
% {f left blark, the defoult PIN wil be used )
Request Device
Elustooth Device Addiess;  00:03:7A02CRET
Blustooth Device Mame:  BT-4P-1

[ ok ][ cace ]

Service detection and COM port creation will be performed automatically.

The [Add New Connection Wizard (Create Connection Destination)] window will
appear.

6. Enter the connection name, user name and password, then click on the
[Next] button.
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Add New Connection Wizard

Create a connection setting

Flzaze give the connection a name, and if required, a user
name and passwand.

Confechion name: Diect Cormeclion
LIzt nanme:
Pazsword:

Confiom pasawond:

| <Back || Newt» || Cancal |

Note
- The user name and password are entered here to allow you to connect to the
access point.

The [Add New Connection Wizard (Confirm Dial-up Settings)] window will appear.

7. Click on the [Confirm Settings] button.

Add Hew Connection Wizard

Pleaze confitm a dial-up zetting

IF [Mener dial a connection] has been salected n the
Inbemet propesties, connections made accanding la the
COM Autoconmect settings vall ot funclion properky.
Flease press the butlan below o conlim dizl-up seltings,

| <Back || Newt» ]| CcCancal |

8. Configure the connection method, and then click on the [OK] button.
Set the connection destination used for the LAN connection set up in (6) above as
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the default connection destination, and then select "Always dial my default

connection."

Internet Properties E

| General | Secuity | Privacy | Cortert | Connections | Piagrams  Advanced |
= Toset Inkermeat ki bk

ﬁ‘% 08 Iupan connection, ¢

Dialup and Virtual Private Metwork settings
&3 Direct Connection [Defaul])
Chease Settings if you need to configure 2 prosey Setlings...

server for a connection.
() Heves dial a connection
() Dial whenever a netwark connection iz nat present
(® [Blways dal my defaull connection

Current Diresct Conruction

Local drea Metwork [LAH] zettings

LA&N Settings do not spply to did-up connections. LAM Seflings...
Choose Settings above for dial-up settings.

[ ok ][ comce |[ Acph |

9. Click on the [Next] button.

Add Hew Connection Wizard

Please confitm a dial-up zetting

I [Mever dial a connection] has been selected nthe
Intemet propesties, connections made accarding o the
COM Autoconmect settings will ot lunclion propery.
Flease press the butlan below 1o conlim dizl-up settings,

| <Back || Newt» ]| Cancal |

10. Enter the type and name of the icon displayed after registration, and then
click on the [Next] button.
Please click on the [Next] button if you are satisfied with the settings.
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Add Hew Connection Wizard

Enter a name and zelect an icon.

Set up the conmechion name and icon.

Settng irdomation

Lonnection Name:
BT-AP1(192168100.11] [Divect Connection]
lcaon
2=

[ Create a sharteut on the deskiop

[ <Back | Mew> | [ Cancel ]

11. Click on the [Finish] button.

The access point icon will be registered in the [Bluetooth Settings] window.

R

BT-AP-1(192.1
68,100 11)
[Direct

Connection]
Connecting to a LAN(LAP)

1. Right-click on the connection icon in the [Bluetooth Settings] window, and
then click on [Connect].

L' Bluetooth Settings mE =
Bluetooth  View Help
3 Bluetooth
: %
i =
S
ET-AP-1{1%
68,100.1 Conneck
[Direct
Conmectic
Dielete
Create Shortout on Deskbop
L | Remame :
| (Change loons...
i i New Ty 104 | e x Dhbata :
: curu-m ;
;rE. :
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2. Confirm that "Direct connection" has been selected under [Connection
Destination], and then click on the [Connect] button

Dial-up Connection
- Selech the senvice pou wank bo connect
:_js.l to, ard thern enter pour uges name and
passwond,
Copnectboc | Direct Connection w
Llser name:
Passwead
[ 5ave pazsword
| Connect [ Setlings... J l Cancal ]

A connection will be initiated.

Note

- This is an example of what happens when you use "Direct connection" as a
connection name under "Connect to access point." If a name different from the
connection name is used, that name will appear under [Connection
Destination].

- Please simply click on [Settings] if no user name or password have been
entered (i.e., if those fields have been left blank)

- Please change the connection destination if a different connection name (for a
dial-up connection) appears in [Connection Destination].

Direct Cormection ~ |

E Connection |
London &

Once you connect to the network, Internet Explorer will start automatically, and you
will be able to exchange data with other computers on the network.

Note
- Please follow the procedure below if you need to set up a proxy server to

connect to the Internet (the following procedure is not necessary if the PC you
are going to use has already been set up as a proxy server).

1. Select [Internet Options...] from the [Tools] menu in Internet Explorer.

The [Internet Options] window will appear.
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2. Click on the [Connections] tab, and then click on the [Settings...]
button.

Internet Properties 23

. Toset up an Inbermst connection, chck _
'.Ig 3 I"'F' ; Setup..,

Disalup and Vitual Prvate Metwoark setings

55 Direct Connection (Defaub) [ _aga.

Londar & |

Choose Sattings if you needto configure 3 proxey | Settings . |
server for a connection. &

() Meves dial a conneclion

{:} Diial gehenever & network connection i nat present
() Alwates dial mie defavll cannection

Current Direct Connection

Local Area Metwork [LAH] zeltings

LAN Settings do not spply to did-up connections. Seltings...
Choose Settings abowve For dial-up settings. M

[ ok J[ concet |[ aoob |

3. Enter the IP address and port number of the proxy server under [Proxy
Server], and then click on the [OK] button.

........... T —— EE

Automatic configuration

Autcenatic configuration may override manwal settings, To ensure the
use of manual settings, disable sutomatic configuration,

[l tuskomatically detect sentings
[[] Uise anstomatic confiquration soript

e

Prouy sarver

Elusna progy server for this connection {These settings wll mot
apply to other connections),

Address: | 172.17.40.100  Port: | 80 pry——
[eypass proxy server for local addresses

Dial-up settings
Lser narma: Properties
Bossword [duanced |
Choamnan:

Lok ][ cance |




4.2.2 Connecting to a LAN using an access point[PAN]
Setting up the access point

Important

- The access point must have been started and a normal connection already
established to the network before the access point is set up. Please refer to the
access point instruction manual for information on how to set up the access
point.

- A Bluetooth passkey (PIN code) is required for you to connect to the access
point. Please make a note of your Bluetooth passkey before you start the set-up
process.

2. Turn on the access point, and confirm that a connection has been
established with the network.

3. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add Mew Conmection
Device Properties

Pawer OFF

Ciptions 3

Help
Exit

- ¥, Qs «

Note
- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings],
and then click on [New Connection] from the active [Bluetooth Settings] window.

4. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.
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"fldd Haw Connection Wizard

Thit wizard will create the setling: for Blustooth device connection.

Please ensure pour Bluetooth devices are on and sef to
dizcoverable.

() Cugtom Mode
Thiz alloves pou to set the detas for the connechion.

e | | m—— ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

"ldd Hew Connection Wizard

Searching for Bluetooth devices.

Seaching for Blustooth devices.

5. Select the device name of the access point from [Device List], and then click
on the [Next] button.




fdd New Connection Wizard

Select a device

Please choose the Bluetooth device you wizh bo use.

Bluetocth denace addiess

Device hzk
Diawice Mame Dewice Addies: S
{BT-AP-1 OO 40ECRCACET

| <Back || New» || Cancal |

You will be asked for the Bluetooth passkey in the window that appears.

6. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on
the [OK] button.

Bluetooth Manager - Bluetooth Security

Blustooth Passkay [FIN}
ﬁ {1 left Elarik, the default PIN wil be used )
Fequest Device
Blustooth Device Addiess: 0004080508087
EBlustooth Davice Mame:  BT-ap-1  [192168.100.21)

[ ok ][ conca |

Service detection and COM port creation will be performed automatically.
The [Add New Connection Wizard (Connection Name Settings)] window will
appear.

7. Enter the type and name of the icon displayed after registration, and then
click on the [Next] button.
Please click on the [Next] button if you are satisfied with the settings.
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fdd New Connection Wizard

Enter a name and zelect an icon.

Setup the conmechion name and icon.

Setbng irfomation
Connection Marme:

BT-aP-1  [19216810021)

lcion

R

[[] Coeate a sharteut on the deskiop

| <Back || Newt» || Cancal |

The [Add New Connection Wizard (Completing the Add New Connection Wizard)]
window will appear.

8. Click on the [Finish] button.
The access point icon will be registered in the [Bluetooth Settings] window.

B

H =
L BT-AP-1
1921680172)

This will complete the access point set-up process.
Connecting to a LAN(PAN)

1. Right-click on the connection icon in the [Bluetooth Settings] window, and
then click on [Connect].
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w Bluetooth Settings

B[=1 %

Bhestooth View Help

3 Bluetooth

=

23

=5
B= gi®

Conneck

Connechic
Delate

Detail...

Renams
Change lcons...

Create Shorbout on Deskbop

s o | | 7€ Defete
1) Cannection

2. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on

the [OK] button.

Bluetooth Manager - Bluetooth Security

Blustooth Passkey [PIN}

w0

Request Device
Elustooth Device Addiess:
Elustooth Device Mame:

[IF It harik, the default FIN wil be used ]

00:40:8C:5C:6C 87
BT-AP-1  [192.168.100.21)
Lok || cancal

A connection will be initiated.

Note

- Please follow the procedure below if you need to set up a proxy server to

connect to the Internet (the following procedure is not necessary if the PC you
are going to use has already been set up as a proxy server).

1. Select [Internet Options...] from the [Tools] menu in Internet Explorer.

The [Internet Options] window will appear.

2. Click on the [Connections] tab, and then click on the [Settings...]

button.




Internet Properties 23

. Tooset up an Intermest connection, chck _
'.5 : I"'F' ; Setup..,

Disalup and Vitual Prvate Metwoark setings

&5 Direct Connection (Defaub) [ agd.

Londar & |

Choose Settings F you need to cofigure 3 prowey | Seltings.. |
server for a connection. 2

() Meves dial a conneclion

() Dial whenever a network conhection i rot plesen
() Alwates dial mie defavll cannection

Current Direct Connection

Local Area Metwork [LAH] zeltings

LAN Settings do not spply to did-up connections. Seltings...
Choose Settings abowve For dial-up settings. M

[ ok J[ concet |[ aooh |

3. Enter the IP address and port number of the proxy server under [Proxy
Server], and then click on the [OK] button.

Local Area Network (LAM) Settings (2Je3d
Automatic configuration

Automatic configuration may override manwal settings, To ensure the
use of manual settings, dissble sutomatic configuration,

[ wskomaticalky detect settings
[[JUse automatic configuration script

Address

Priiy server

Ll:sca provey server for vour LAN (These settings will not apply ko
dial-up or YPN conneckions).

Address:  172.17.40,100  Pork: | 80  advanced. . |
[ ]Bypass prowy server for local addresses

[ ok ][ conca |




4.3 Sending files

You can send and receive files other than business card data with a Bluetooth-enabled
PC or PDA.

Use "File transfer" in the Bluetooth Information Exchanger to exchange files.

Note

- The same operations will be valid as long as the PC and PDA support the FTP
profile

- "File transfer" cannot be used to send or receive business card data. Please
instead use "Object Push" to perform these activities.

4.3.1 Exchanging files with a PC or PDA
Sending files to a PC or PDA
1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

[{{Tn}

Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.
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'_7Bluetooth Information Exchanger =iaey
Fle ‘Yew Favorbes Tools  Blustooth  Help o

Qo - @ (F| P soeh [y roes ||| (] (2 s
e | TSR 03 %, On
E} Desktop
& () My Documenks FleTrorsfer  Image  Object Push
F: T

# W oy Computer
=] g My Metwork Places
& Recycl Bin
£ “1¥ Bluetooth Information Exchanger
® B3 Fle Transfer
® 9y [mage Transfer
& 5 object Push

3. Double-click on the [File transfer] icon.

A list of devices will appear in the [File transfer] window.

23 File Transfer EEE

Bl ‘Wew Faworibes Tools  Buetooth Help

Qe @ - [F Psewer i rotes |7 [ =
. Lt
Shared Folder PC-1 POA-1 POA-2

Note
- If the desired device does not appear in the list, please confirm that the device
has been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.
- You can also use "Image transfer" when sending individual image files.




4. Use the mouse to drag and drop the file you wish to send over the destination

icon.
In this case, the file will be sent to a PC named "PC-1".

Qo - © (| P [ rotn [ [

=T

=hared Folder PC I POw-1

LLJ@J}E“@‘I

3 L
FETEE  re-2it

Note
- When using "File transfer", you can send individual files as well as entire

folders.

5. Confirm that the file is being sent.
The file will be sent to the PC.

Note
- When sending files using "File transfer", a message requesting permission to
receive the files may appear on the destination (receiving) device. The content of
the message will vary with the Bluetooth software installed on the destination
device, so please be sure to follow the instructions provided.
If you are using the Bluetooth Utility, a message similar to the one below will

appear.

File Receive Confirmation

Do pou allow a Connect Regueast fom 00:03:2F04BAF3?

Save Folder
CADocuments and Setlings\ddministratotMy Document:

i ok ] | Cancel |

If the file has been sent successfully, the message below will appear.
Please click on the [OK] button.




Bluetooth 3

-
\!’I’) File brarsfer was successful.

The message below will appear if the file transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure

‘Bluetooth E
A Sending of file falad.

Note

- Files that have been sent will be saved in a file transfer shared folder on the
destination device.

- Additionally, with "File transfer", you can open the shared folder on the
destination device using Explorer, specify a subfolder, and then send the file
there.

L7 Personal

Folders
L—,} Deskiop
# () My Documents
® 5 My Computer
+ \] My MNetwork Hlaces
= Recyde Bin
= ¥1% sluetooth Information Exchanger
= B2 Fle Trarcfer
% 03 shared Folder
= M pow-1
# [ Busness
= ' Personal
# 1 Falder-1
¥ ] Templakes
# %4 Image Transfer
# B obgect Push

El=  ‘ew Fawvoribes Tools  Euetooth Help

@Bﬂ{k * & ? 7 Search Il

;‘r
{5 releers || [75] 5] 23] (550
x i e
~ T
Folder-1 Fie-1.txt

- You can use Properties in the Bluetooth Information Exchanger to change the
location of the "Shared folder" on the hard drive.

Receiving files from a PC or PDA




Your PC is able to receive files that have been saved in the shared folder on the

destination PC or PDA. Received files will be saved in the shared folder under "File
transfer".

1. Turn on the PC or PDA.
Confirm that a Bluetooth connection has been enabled before proceeding.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

((c»))

Eluekoakth
i ion
Exchanger

Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

- _—
¢ Bluetooth Information Exchanger L.:..ED.J
Fie Vew Favorbes Jools Buetooth  Help s
Qo - © 3 O sener | s | D) [ (20
Folders X % é% IE
|_-_»} Deskiop
@ {5} My Domments File Transfer Image Cibject Push
@ ' My Computer Jraneler
=] ‘ﬂ My Metwork Places
_;.II Recyce Bin

= 9% gluetooth Information Exchanger
[+ % File: Transfes
= Image Transfer
B % Obgect Push

3. Double-click on the [File transfer] icon

A list of devices will appear in the [File transfer] window.
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(23 File Transfer LIoEd
Fle Yew Favorbes Tools  Bluetocth  Hep i
a Back ~ J ? 7 Search |- Folders EI Ej m D
address | QS Bustaath Information Exchanger!File Transfar ﬂ a0

5 A § @8

Shared Folder PC-1 PDA-1 PDA-2

In this case, the file will be received from the PDA named "My Mobile".

4. Double-click on the [PDA-1] icon
The file saved in the shared folder in "My Mobile" will appear.

5. Right-click on the file you wish to receive, and then select "Receive file".

Irf;_.'i Personal g@]

Fla  View Fawvoribes Tools  Eluetocth  Help
Qo -
—

Folder-1 File-1 bt

Recerve Fils
Delebe

 POsemer [ e | ] [ 3

The file will be received from a PDA.

Note
- With "File transfer", you can send individual files as well as entire folders.
Please right-click on the folder you wish to receive, and select "Receive folder".




@Baﬁk T W ? s
Falder-1 File-1.txt

Open
Explarer

Subsequent operations should be performed in the same manner as when
receiving individual files.
If the file has been received successfully, the message below will appear.
Please click on the [OK] button.

Bluetooth
jf) Fila bransfer was successhul,

The message below will appear if the file transmission was unsuccessful. Please
click on the [OK] button to close the message, and repeat the procedure.

Bluetoath 3|

L\x Sending of file fafled.

Note
- The received file will be saved in the "Shared folder" under "File transfer" in the

Bluetooth Information Exchanger
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Efa Edt ‘Wew Favorkes Jools Help #
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Folders ® 5

# [} My Doouments al | ||I Folder-1
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= ¥1% Bluetooth Informstion Exchanger | S

= % File Transfer
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|='_F_, 1 KB
£ M ppa-1
& & poa-2

# L Tmage Transfer
# D obiect push wig

File-1, =t

You can use Properties under the Bluetooth Information Exchanger to specify
the location of the "Shared folder" on the hard drive.

4.3.2 Sending images to a mobile telephone

1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

((ce)

Eluetookth
i ian
Exchanger

Note
- The mobile telephone must support the BIP profile.

- The image file”(*.omp)(*.jpg,*.jpeg)(*.png)” formats can be sent and received
using "Image transfer".

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.
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3. Double-click on the [File transfer] icon.
A list of devices will appear in the [File transfer] window.

3 File Transfer s
Fle Vew Favortes Joos Bluetooth Hep i
@Eﬂd‘: - \_J ? ’;r‘?iuarl:h it  Feiders Ei|. . .

A gres %&JE‘E&E‘}I ]I'Ifﬂrl'l'm EII:hHh]ﬂr'I.Fh TF-H'ISfEr “-;ﬂ Gﬂ
PC-1 PDA-1 PDA-2

4. Drag and drop the file you wish to send over the destination icon.
In this case, the image will be sent to a mobile telephone named "BT-Phone-1".




r?_.} Imaee Transie:

@Bu-ck » & ? l|‘,'.‘51:.:\‘-ch 4 Folders |[:::]|E r_:'] D
G i
Irnage [nBox  BT-Camers-l  BTFE

The image will be sent.

If the image has been sent successfully, the message below will appear.
Please click on the [OK] button.

Bluetooth =
\jl') Image transfer was suooesshul.

The message below will appear if the image transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

‘Bluetooth ||
1
ﬁ Sending of image Falled.




4.4 Exchanging business card data with a PC or PDA

You can exchange business card data with a Bluetooth-enabled PC or PDA.

Business card data are exchanged using "Object Push" under Bluetooth Information
Exchanger.

Selecting a business card and sending it to a PC or PDA

1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

(o))
ol

Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

- p—— . %
¢ Bluetooth Information Exchanger L.:HLI;JJ
Eie Wew Favorbes Tools Buetosth Hep o
@Bxk - & ? F, ! Search |:_' Folders E m r:'-ﬂ D Address
B 5 =

|_-_»} Desktop
# ) My Documents File Transfer Image Cibject Push
¥ -‘j, My Computer Transfer

® & My Network Places
= Recyce Bin
= 9% gluetooth Information Exchanger
[+ % File: Transfes
* “‘:_[‘;. Image Transfer
5 B object Push

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.
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(54 Object Push LoEd
Fie Yiew Favortes Tools Buetocth  Help o
@Buk * ? 7 Search | Folders El j [: Ij
m W B
B
Inbox Piz-1 PL-]

Note
- If the desired device does not appear in the list, please confirm that the device

has been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

4. Use the mouse to drag and drop the business card you wish to send over the
destination icon
In this case, the business card will be sent to a PC named "PC-1".

Inbices Pr-1 POu-1
=10k
_lffl'
.ﬁ_l
Rose
Goody . vof

Note
- When you try to send a business card, a message requesting permission to
receive the card may appear on the device belonging to the other party (i.e., on
the receiving end). The content of the message will vary with the Bluetooth
software installed on the destination device, so please be sure to follow the
instructions provided. If you are using the Bluetooth Utility, a message similar to
the one below will appear.




File Receive Confirmation

Do pows weank bo receive a Busness Card fiom 0003 TA:02:.C3:877

Save Folder
CADocuments and Setlings\ddminstratortiy Document:

o] o]

If the business card has been sent successfully, the message below will appear.
Please click on the [OK] button.

Bluetooth

-
"‘ll‘) Busingss Card transfer was successful.

The message below will appear if the business card transmission was

unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

ﬁluﬂooth E

I‘_\ Sending of Busimass Card Falled.

Selecting your personal business card

You can prepare a business card bearing your name and other details such as your
company and telephone numbers, and then send it to another party.

Note
- Alternatively, opening Explorer and clicking on the Bluetooth Information

Exchanger folder will produce the same result.

1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.




Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

|_}Blu TR, n[‘.l;ch.nngil ...................................... L.-‘:JLEUE
Fla Wew Faworites Tools  Bustooth Help o
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i | |
e NINCSISTEN 03 9 On
Ez} Desktop g
# ) My Documents File Transfer  Image Chiject Push
B rJ My Compuber Transfer
=] \g My Network Flaces
= Recyck Bin

& 1% Bluetooth Information Exchanges
# B3 Fle Transfer
) E; Image Transfer
® Bs ohject Push

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.

U4 Object Push e
il

Efa Yew Favoribes Jools Eluetooth Help

@Bﬂ:k“ d ? K'Sear:h | Folders .ElED

- A 8

Inbox PC-1 PD-1

Note
- If the desired device does not appear in the list, please confirm that the device

has been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.
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4. Right-click on the destination icon, and then click on [Send business card
To].
In this case, your personal business card will be sent to a PC named "PC-1".

C24 Object Push e X
Fle ‘iew Favorites Tools  Blustooth  Help i

@Bﬂtk b | 1}‘ P, | Search || Folders E D E

= B B

Inboo PC-L oo
Open

Explarer

Property
Diglata
Sefvice Discovery

Send Business Card To
Receive Partner's Buginess Card From
Exchange Iy Business Card

The business card will be sent.

Note
- When you try to send a business card, a message requesting permission to
receive the files may appear on the device belonging to the other party (i.e., on
the receiving end). The content of the message will vary with the Bluetooth
software installed on the destination device, so please be sure to follow the
instructions provided. If you are using the Bluetooth Utility, a message similar to
the one below will appear.

Bluatooth

‘?J’/ Wil you allow a Business Card transfer bo 00:03: 7A:02:09:5377

e | —

- Business cards that have been sent will be saved in the Inbox of the destination
party.

If your business card has been sent successfully, the message below will appear.
Please click on the [OK] button.
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Bluetooth

-
lr} Busingss Card transfer was successful,
\..,

The message below will appear if the business card transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

Bluetooth ﬁ
I E Sending of Busiess Card Failed,

Note
- Data that has been sent will be saved in a folder for exchanged business cards
on the destination device.

Receiving a business card from another party

You can prepare a business card bearing your name and other details such as your
company and telephone numbers, and then send it to another party.

Note
- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

Note
- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.
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3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.

(54 Object Push | =}

Eia ‘iew Favortes Jools  Bustocth  Help o
@Bﬁk-‘ > . 7 ) search ||~ Folders 2|2 G E

= B B

Inbio PDA-]

Note

- If the desired device does not appear in the list, please confirm that the device

has been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

4. Right-click on the icon of the party whose card you wish to acquire, and then
click on [Receive business card]

In this case, the business card of the other party will be acquired from a PC named
"PC-1".
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Tnbox Pl Explorer

Property
Cielete
Service Disoovery

Send Business Card To
Exchange My Business Card

The business card will be received.
Exchanging business cards
Simultaneously exchange your business card with one belonging to another party.
1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

((ce))

Eluetookth
i ian
Exchanger

Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.
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3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.

(54 Object Push | =}
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= B B

Inbio PDA-]

Note

- If the desired device does not appear in the list, please confirm that the device

has been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

4. Right-click on the icon of the party with whom you wish to exchange
business cards, and then click on [Object Push].

In this case, the business cards will be exchanged with a PC named "PC-1".
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Open
Explores
Froperty
Delete

Service Digcovery

Send Business Card To
Receive Partner's Business Card From
Exchange My Business Card

The business card from the party who executed the "Exchange business cards"
command will be sent first.

Note

- When you try to send a business card, a message requesting permission to
receive the files may appear on the device belonging to the other party (i.e., on the
receiving end). The content of the message will vary with the Bluetooth software
installed on the destination device, so please be sure to follow the instructions
provided.
If you are using the Bluetooth Utility, a message similar to the one below will
appear.

File Receive Confirmation

Dhiy yoo ek b recerve & Busness Card o D0003: 74:02:C3:877

Sanve Folder
CA\Dacuments and Setlings\AdminiskratorMy Documen:

ook § |, Cancel |
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4.5 Synchronizing data with a PDA

When you connect via Bluetooth instead of with a standard cable, you will always be able
to synchronize your data without the hassle of having to connect the cable.

4.5.1 Connecting using ActiveSync
Preparing the PC
1. On the PC, click on [Start]>[All Programs]—>[Microsoft ActiveSync].
The initial ActiveSync set-up window will appear.

It is assumed in the explanation below that no ActiveSync connections have been
established with other devices.

& Microseft ActiveSync Gj
Ede View Tools Help I

Details

No partnerships @
Mot connected L

Information Type Status

2. Click [File]>[Connection Settings].

& Microsoft ActiveSync E] '
CFie View Toole Help

Get Connected. .,
Connection Settings..,

Chosa

e ——————
(ﬁ_*}
=
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The [Connection Settings] window will appear.

3. Place a check next to [Allow serial cable or infrared connection to this COM
port], and then select "COM7".

Connection Settings

= Chck Get Connected o connect your mobsle device to this
L‘ﬂ CompLibe

Status: ‘Wating foe device bo connect Get Conneched..

[+ Allows zenal cable or infraned conmection to thiz COM port:

oM7Y s

Stabus:  COM por is not available

¥ Allow USE connection with this deskiop computes,
Stahes:  USH is awalsble

I+ Allow petwork [Ethernet] and Remote Access Service [AAS)
zervel conneciion with this desklop computer,

Stabuz  Metwork iz avalabls

Shalus icon
[ Show stabes joon in Taskbar,

[ ok ] cowel | Hep

Note
- In the standard set-up, the port is configured to "COM7" (refer to Steps (3) and
(4) under "Preparing the PDA" below). When using a different port, please also
change the port number selected in this window

Preparing the PDA

1. Tap on the Bluetooth icon in the bottom right of the screen.
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e

(¥ |start M AT W 10:31

i@ Tuesday, October 14, 2003
[5] Tap here bosst owner information

Important
- The graphic above shows an example of a PDA operating window.
The connection procedure may be different depending on the manufacturer or
model of PDA you use. Please refer to the product instruction manuals for further
details.

The [Bluetooth Settings] window will open.
The message "Connection not registered" will appear if no Bluetooth device has
been registered.

7 | PRI
."j{,,’ |Bluetooth Sett "1V & o< 12:01
fix: | :

| BEluetooth Settings

Connection registration
could not be performed.
Before establishing a
Bluetooth connection,
sedect the sarvice to which
Yo want to connact and
regster the cornection,

= This message Is displayed at the [Z
4 time of startup.
Tools ¥iew Options CF, =] 8

Please tap on [OK] to close the message.

2. Double click on [Tools]=>[Search for peripheral components].
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!

Remote Devices Status

Service Mame | Status Description

Device Search

Search Options »
Delete Ghost Devices...

Tools|Yiew Options OQ E|*
T

The application searches for nearby Bluetooth devices.
3. Tap and hold on the destination PC icon, and then select [Update Services].

{7 |pluetooth sett *1* 3F € 12211 (D |

Service Name | Status | Desaription

|Tools ¥iew Options € EI*

A search for services will be carried out, and then a list of service names and their
connection status will appear as list in the lower window.




Service Mame | Status | Description

=COM7 Mot C..  SerialPart(T..,
File Trans..., Mot C... OBEX File Tr...
Chject P... Mot C... OBEX Ohjec...

Tools Yiew Options q E|*

4. Tap and hold on "COM7" from the list of service names, and then select
"Register ActiveSync".

i3 [Bluetooth sett *1? & < 12:15 (DY

p-1

Service Mame | Status | Description

b
File T
% ; Connection Registration
Flobjec L
Properties

Tools Yiew Options q E|A

5. Tap [OK] in the confirmation message window.

81



ef‘}' Bluetooth Sett t:T:':I & € 12:13 @

ActiveSync Auto Connect

Bedinning ActiveSync Auto
Connect, To use a

function other than
ActiveSync Auto Connect,
cancel this setting,

(1] 4 Cancel

SEFVICE [NATTE [ =Tats DIEECFETION

LG CanaPort(T
Mot C...  OBEX File Tr...
ﬁ'ﬂ@bject P... MotC.. OBEX Chiec...

Tools ¥iew Options q E|A

An ActiveSync connection will be initiated.
Establishing a partnership between ActiveSync and a PDA

Once a connection has been successfully established with a PDA, the procedure for

establishing a partnership with the PDA will be started by the ActiveSync application on
the PC.

Performing this set-up procedure will enable data to be synchronised between your PC
and PDA.

1. In the [New Partnership (Set Up a Partnership)] window, select "Standard

partnership”, and then click on the [Next] button.




Hew Partnership

Set Up a Partnership

This wizatd helps pou establish a paitneship betveen your
mobile device and this compates. ‘You can set up either a
standand patnedzhip 1o synchiorize data babwesn pour
dewice and this computer. or 4 guest pattnership bo simply
transfer data betweaan pour dewice and this compuber.

what kind of parinesship would wou ke fo establsh bebwesn
wour device and this commputes?

(% [Standad parnesshig
| wrant ko syncheonize data bebaesn my device and
thig computer, keeping data such as e-mail and
calendar tems uo-to-dale in both places

" Guest parineszhip
| weard o arly copy and move infaimation bebween my
device and lhiz computer, add and remove progiams,
of feslae & backup mage on a device whose memany
has been reset. | do not want fo syncheorsze data.

Mest = Carnczl | Help |

The [New Partnership (Specify Data Synchronisation Method)] window will appear.

2. Select "Synchronise with this PC", and then click on the [Next] button.

Hew Partnership

Specify how to spnchronize data r—ih'i
Choos to syncheoreze with pow deskiop andfor a server -

You can spnchronize data, such as e-mal messages and calendas items, bebwesn pour
dewice and thiz deskilop computer. However, f you have access bo a Mictosoft Exchangs
Server with Exchange ActveSpne, you can also choose some informahan tppes to
smchionze diecly with a server, geting the most up-to-date infomabion, esvan when pour
desklop computer i lumed off

How dio pou want bo spnchronize vith pour device?
& ynetuonas wih s geskion comprie]
™ Syncheonize with Micioscit Exchange Server and/or this deskbop computer

[Mabe: vou must have access 1o Miciosalt Exchange Serer with Enchange ActhveSyne
or Miciosoét Mobde Information Senver. )

¢ Back Mest > Cancel | Help

The [New Partnership (Select Synchronisation Settings)] window will appear.

3. Select the type of information to be synchronised between your PC and PDA,
and then click on the [Next] button.
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Mew Partnership

Select Synchionization Settings rh
Select the bpe of infomnation you want o smchionize M

To sgnchionze a particular type of information, select k2 check bow. To glop
spnchronizabion of thal information, clear its check bow

Mobie Device | Deskiop Computer [ A
RERE e
w1 2 Calendar Microzoft Dutlock
I [=] Contzcts Microsoft Dutlock
W 3 Fanvonbes Inbermet Exploner

| 251 Fies Synchionized Files
A ) Ik Microsoft Dutlook

IfsJ Notes Microsoft Oullook a

T find out mane sbaut and to customize what gets synchionized, click
i that mformation type in the list and then chck Setings.

¢ Back Mesd > Cancel | Heip |

The [New Partnership (Completing Setup)] window will appear.

4. Click on the [Finish] button.

Hew Partnership

Setup Complete

fou are naw 1eady to stait exchangng infomation betwesn
wour mabile device and this computer

U peey esaling this wizand, Mictosodl ActiveSyre wil apen and

IF your device ks & guest, chck Explore on the toolbar and
start explorig wour device

It your dewvice has a parinership, syncheonization slarts.
Flaaze wail unhl synchaorizalion iz complete before uging
your device,

Chck Firish bo et this wizard

Carncal | | |

When you click on the [Finish] button, ActiveSync will begin to synchronize your
information.

[Confirming changes]
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While the ActiveSync connection is active, synchronization will be performed
whenever information is changed on either the PC or the PDA.

Once a partnership has been established, every time you start your PC (and PDA)
thereafter, a Bluetooth connection will be opened and ActiveSync will synchronize
your information.

Finishing an ActiveSync connection

Tap and hold on "COM7" in the Bluetooth Settings window, and select
[ActiveSync Release].




Connection Registration

Properties

Tools Yiew Options q E|A

Cancelling a partnership
Click on [File]>"Delete partnership”.

Click on the [Yes] button when the confirmation message appears.

|§]‘Mil:msu-ﬂ ActiveSync |l] E
Fle View Tools Help

Mobile Device ]

Dedebe Partnership

Get Connected..,
Conmection Settings. ..

Chose

[Slcalendar
[=lcortacts
Tasks
P avorkes
LlIrbcl:-t




4.6 Fax transmission
4.6.1 Using a modem station for fax transmission

Important

- Please refer to the modem station instruction manual for information on how to
connect the station to a telephone line.

- Please ensure that any drivers used to connect the PC to the modem have
been installed.

- A Bluetooth passkey (PIN code) is required for you to connect to the modem
station. Please make a note of your Bluetooth passkey before you start the
set-up process.

- A fax application is required for you to be able to send and receive faxes. The
description below is based on a example using Microsoft Fax, which is installed
with Windows XP as standard.

If you are going to use a commercially available fax application, then please refer
to the manual that came with the application for information on how to send and
receive faxes.

Setting up the modem station
1. Turn on the wireless modem station.

2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add Mew Connection
Dievice Properties

Puawveer OFF

Cipiions k

Hedp

Note
- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings],
and then click on [New Connection] from the active [Bluetooth Settings] window.
The [Add New Connection Wizard (Welcome to the Add New Connection
Wizard)] window will appear.

3. Select [Custom Mode], and then click on the [Next] button.
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Add New Connection Wizard

Welcome to the Add Mew Connection Wizard

Thiz vazard registers te connection information of a remole
device.
Select the wzard mode.

() Expuezs Mode [Recommended)
The miosh uzeful service on a remobe device iz set up,

(=) Cugtom Mode
An avalable senace on a remole device iz selected and set

[ bew> | [ Cancal ||

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

"ﬁdd Hew Connection Wizard

Searching for Bluetooth devices.

Searching for Blustooth devices.

Once the program has finished searching for the devices, the [Add New
Connection Wizard (Select Device)] window will appear.

4. Select the device name of the wireless modem station from [Device List], and
then click on the [Next] button.






